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Thank you for purchasing an Olympus
Digital Voice Recorder.

Please read these instructions for information
about using the product correctly and safely.

Keep the instructions handy for future reference.

To ensure successful recordings, we recommend that
you test the record function and volume before use.

ONLINE
INSTRUCTIONS

EN

DIGITAL VOICE
RECORDER

DS-3300
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Convention Used In this Manual
• The word “card” is used to refer to the xD-

picture Card.

• The word “DSS Player” is used to refer to
the DSS Player Pro Dictation Module in
Windows environment and DSS Player in
Apple Macintosh environment.

• The Notes at the bottom of a page are used
for additional information, exceptions, or
related events.

• Words in uppercase form such as PLAY or
REC are used to describe a function,
button, or switch position on the recorder.

• The icon indicates that feature or
setting can be modified by Professional
Olympus Authorized Dealer only.

Safe and Proper Usage
Before using your new recorder, read this
manual carefully to ensure that you know
how to operate it safely and correctly.
Keep this manual in an easily accessible
location for future reference.

Important Safety Precautions
Certain symbols are used in the user’s
manual and on this product to help
protect users, their surroundings, and
their property from possible injury or
damage. Please familiarize yourself with
the following definitions and meanings
for each symbol before reading the
precautions.

Symbols prohibiting a specific action

Prohibited
Do not
disassemble

Symbols requiring a specific action

Mandatory Unplug from
power outlet

Danger

Signifies danger which
may result in serious
injury or death.

Warning

Indicates items or actions
which may cause serious
injury or death.

Caution

Indicates items or actions
which may result in damage
or personal injury.
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General Precautions
� Do not leave the recorder in hot, humid

locations such as inside a closed
automobile under direct sunlight or on
the beach in the summer.

� Do not store the recorder in places
exposed to excessive moisture or dust.

� Do not use organic solvents such as
alcohol and lacquer thinner to clean the
unit.

� Do not place the recorder on top of or
near electric appliances such as TVs or
refrigerators.

� Avoid recording or playing back near
cellular phones or other wireless
equipment, as they may cause
interference and noise. If you
experience noise, move to another
place, or move the recorder further
away from such equipment.

� Avoid sand or dirt. These can cause
irreparable damage.

� Avoid strong vibrations or shocks.
� Do not disassemble, repair or modify

the unit yourself.
� Do not operate the unit while operating

a vehicle (such as a bicycle,
motorcycle, or go-cart).

� Keep the unit out of the reach of
children.

<Warning regarding data loss>

Recorded content in memory may be
destroyed or erased by operating
mistakes, unit malfunction, or during
repair work.
It is recommended to back up and save
important content to other media such as
a computer hard disk.

Batteries/Rechargeable
Battery Pack (BR402)

 Danger

• Do not solder lead wires or terminals
directly onto a battery or modify it.

• Do not connect the  and  terminals
together. This may cause fire,
overheating or electric shock.

• When carrying or storing the battery
(BR402), be sure to put it in the provided
case to protect its terminals. Do not carry
or store the battery with any metal objects
(such as key rings). If this warning is not
followed, fire, overheating or electric
shock may occur.

• Do not connect the batteries directly to
a power outlet or a cigarette lighter of
an automobile.

• Do not insert the batteries with their 
and  terminals reversed.

• If any liquid from a battery gets into your
eyes, promptly wash it off with clean
water and consult your doctor at once.

• There is a hole from which gas escapes
on the terminal. Do not cover or block
it (BR402).

 Warning

• Batteries should never be exposed to
flame, heated, short-circuited or
disassembled.

• Do not attempt to recharge alkaline,
lithium or any other non-rechargeable
batteries.

• Never use any battery with a torn or
cracked outer cover.
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Battery Charger (Cradle)
 Danger

• Do not attempt to use this charger
with anything other than Olympus
Ni-MH batteries. Using it in
combination with other batteries
may cause fire, explosion, leakage
or overheating.

• Do not put the charger in water.
Using it when wet or in a humid area
(such as a bathroom) may cause
fire, overheating or electric shock.

• Do not use the charger with
batteries that have been
inserted with their  and 
terminals reversed. This may
cause fire, explosion, leakage,
overheating or damage to
batteries.

• Never modify or disassemble
the charger. This may cause
fire, overheating, electric
shock or injury.

General Precautions

 Caution

• BR402 rechargeable batteries are
exclusively for use with Olympus digital
voice recorder DS-3300. Do not use
them in combination with other
equipment.

• Do not subject batteries to strong
shocks.

• Do not use with other types of batteries,
or with batteries that have different
voltages or brand names.

• When using more than two batteries,
charge them at the same time.

• When using new batteries, or batteries
which have not been used for a long
time, be sure to recharge them even if
they were only used for a short period
of time.

 Warning
• Do not use the batteries if you

find something wrong with
them such as deformity or
leakage. This may cause
explosion or overheating.

Do not
disassemble

• Keep batteries out of the reach of
children.

• If you notice anything unusual when
using this product such as abnormal
noise, heat, smoke, or a burning odor:

1 remove the batteries immediately while
being careful not to burn yourself, and;

2 call your dealer or local Olympus
representative for service.

• Do not expose the rechargeable
batteries to water. Do not allow water to
contact the terminals.

• Do not remove or damage the battery
insulating sheet.

• Do not use the batteries if you find
something wrong with them such as
leakage, color change or deformity.

• Unplug the charger if the charging is still
incomplete after the specified time it
should take.

• Should any battery liquid get on skin or
clothing, promptly wash it off with clean
water.

• Keep batteries away from fire.
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AC Adapter
 Danger

• Be sure to use the charger with
the proper voltage (AC 100 - 240
V). Using it with other voltage
levels may cause fire, explosion,
overheating, electric shock or
injury.

• For safety, be sure to unplug the
charger from the outlet before
performing maintenance or
cleaning. Also, never plug in or
disconnect the power plug with a
wet hand. This may cause electric
shock or injury.

 Warning

• Do not attempt to disassemble, repair
or modify the AC adapter in any way.

• Keep foreign objects including water,
metal, or flammable substances from
getting inside the product.

• Do not insert metal wires or
similar objects. This may
cause fire, overheating or
electric shock.

• Keep out of the reach of
children. Do not let children
use this product without adult
supervision.

 Caution
• If charging is not completed (if

the charging indicator is not
turned off) after 3 hours, plug
the power-supply cord out.
Contact the store of purchase
or Olympus Service Station
for repair since it may be a
malfunction.

• Be sure to charge batteries
within the temperature range
of 0°C - 40°C/32°F - 104°F. If
not, there may be explosion,
fire, leakage or damage to
batteries.

• Do not put anything heavy on
the charger or leave it in an
unstable position or in a
humid place. This may cause
explosion, fire, leakage,
overheating, electric shock or
injury.

• Do not touch the charger for
too long when using it. This
may cause a serious low-
temperature burn.

Unplug from
power outlet

• If charging does not finish (or
if the charge indicator light
does not go off) after three
hours, the charger may break.
If this occurs, disconnect the
power plug and consult your
nearest Olympus dealer or
customer support center.

• Do not use or store the
charger in/on an unstable
place, such as a television set,
etc. If it falls, it may cause
injury or break.
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General Precautions

 Caution
• Do not use the charger if the

power plug is damaged or the
plug is not completely
connected to the outlet. This
may cause fire, overheating,
electric shock, short circuit or
damage.

• Unplug the AC Adapter from
AC outlet when not using. If
this precaution is not
followed, fire, overheating or
electric shock may occur.

• Do not moisten the AC adapter or touch
it with a wet hand.

• Do not use the AC adapter in the vicinity
of flammable gas (including gasoline,
benzine and lacquer thinner).

In case
• ... the internal parts of the AC adapter

are exposed because it has been
dropped or otherwise damaged:

• ... the AC adapter is dropped in water,
or if water, metal flammable substances
or other foreign objects get inside it:

• ... you notice anything unusual when
using the AC adapter such as abnormal
noise, heat, smoke, or a burning odor:

1 do not touch any of the exposed parts;
2 immediately disconnect the power

supply plug from the power outlet, and;
3 call your dealer or local Olympus

representative for servicing. Continued
use of the AC adapter under these
circumstances could result in electric
shock, fire or injury.

• Make sure to hold the plug
when removing the power
plug from the outlet. Do not
bend the cord excessively or
put a heavy object on it. This
may cause fire, overheating,
electric shock or damage.

• If something appears to be
wrong with the charger,
unplug the charger from the
outlet and consult your
nearest service center. Using
the charger may cause fire,
overheating, electric shock or
injury.

• Do not use or keep the charger
in very hot places, such as in
direct sunlight, in a closed car
on a sunny day, near a heater,
on an electric carpet, etc. Do not
use the charger if something is
covering it (such as a blanket).
This may cause fire, explosion,
leakage or overheating.

Unplug from
power outlet
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Main Features
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IBM and PC/AT are the trademarks or registered
trademarks of International Business Machines
Corporation.

Microsoft and Windows are registered trademarks
of Microsoft Corporation.

Apple, Macintosh, iMac, eMac, Mac, and
PowerMac are trademarks or registered
trademarks of Apple Computer, Inc.

Intel and Pentium are registered trademarks of Intel
Corporation.

Adobe and Acrobat Reader are registered
trademarks of Adobe Systems Incorporated.

Other product and brand names mentioned herein
may be the trademarks or registered trademarks
of their respective owners.

� Dual function cradle, docking station, for
recharging of the optional Ni-MH
Rechargeable Battery Pack (BR402)
(� P.14)*1 and for downloading data from
the recorder to a PC (� P.61).

� The recorder has multi programmable
button (CUSTOM) (� P.18).

� Recording and storing voice in DSS
format.

� Two recording modes, SP (Standard
Playback) mode or LP (Long Playback)
mode (� P.28).

� Five folders and up to 199 files/folder, for
a maximum of 995 recordings (� P.23).

� Built-in Variable Control Voice Actuator
(VCVA) function (� P.29).

� USB Audio Device, recorder can be used
as a USB microphone or USB speaker
when connected to a PC (� P.76).*2

� Large LCD screen with backlight.

� Multi-level priority setting (� P.43).

� DSS Player software included (� P.50).

� Hands-free recording function when used with
the optional foot switch (RS25/26) (� P.30).

*1 Available only with the optional Ni-MH Rechargeable
Battery Pack (BR402).

*2 Do not use with Windows 98 as computer operation may
become unstable.
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xD-Picture Card
The xD-Picture Card is a removable recording media.

Memory Size SP Mode LP Mode

16MB    2 hr. 35 min. 5 hr. 30 min.

32MB  5 hr. 13 min. 11 hr. 00 min.

64MB 10 hr. 25 min. 22 hr. 20 min.

128MB 20 hr. 55 min. 44 hr. 45 min.

256MB 42 hr. 00 min. 89 hr. 40 min.

512MB 84 hr. 05 min. 179 hr. 30 min.*2

Memory Sizes of Cards and Approximate Recording Times*1

1 Index area
You can write
down the card’s
contents.

Compatible Cards

The removable card can be used to store different
kind of data. Since the card has larger memory
capacity than a diskette, it can be used to transfer
data between different PCs. The recorder supports
cards with memory capacity between 16 to 512 MB. 2 Contact area

Comes into
contact with the
recorder’s signal
read contacts.

*1: Available recording time for one continuous file.
Available recording time may be shorter if
many short recordings are made.

*2: Total recording time of two files. The maximum
recording time per file is 99 hours.

xD
-P

ictu
re C

ard

..............................................................................................................................................................

Notes
• When initializing (formatting) a card, confirm that no necessary data is stored on the card

beforehand. Initialization completely erases the existing data on the card.
• Cards used in a recorder must be formatted in the same recorder first unless formatted with a

CAMEDIA series Olympus digital camera. Card may not perform as expected when formatted by a
different device.

• The card has a service life. When reaching the end of its life, writing or erasing data on the card will be
disabled. In this case, replace the card.

• If you use a PC card adapter compatible with the card to save or delete some data on the card, the
maximum recording time on the card may be decreased. To recover the original recording time, initialize/
format the card in the recorder.

• Olympus will not be held liable for any data corruption or loss due to misuse of the media card.
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1 EAR (Earphone) jack
2 MIC (Microphone) jack
3 Built-in microphone
4 NEW button
5 HOLD switch
6 REC (Record) button
7 REW (Rewind) button
8 FF (Fast Forward) button
9 INDEX button
0 FOLDER/MENU button
! Built-in speaker
@ STOP button
# PLAY button

$ ERASE button
% CUSTOM button

(Programmable)
^ Display (LCD panel)
& Record/Play indicator lamp
* POWER (ON/OFF) switch
( VOLUME (+) button
) VOLUME (–) button
- Card cover
= Card cover lock
q Battery cover
w PC (USB) terminal/Cradle

attachment point

Identification of Parts
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1 Battery indicator
2 Folder
3 Priority indicator
4 Current file number
5 Total number of recorded files in

the folder
6 Erase lock indicator
7 Character Information display
8 Microphone sensitivity display
9 VCVA (Variable Control Voice

Actuator) indicator
0 Record mode indicator

Display (LCD Panel)
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tificatio
n

 o
f P

arts

1 2

3
4
5
6

7

0
9

8

Identification of Parts
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1 Lightly press down on the arrow and slide the
battery cover open.

2 Insert two AAA batteries, observing the correct
polarity.

3 Close the battery cover completely.

Replacing batteries
The battery indicator on the display changes as the batteries
lose power.

When  appears on the display, replace the batteries
as soon as possible.
When the batteries are too weak, the recorder shuts down
and “BATTERY LOW” appears on the display.

  →    →    →  

AAA alkaline batteries

..............................................................................................................................................................

Notes
• Be sure to turn OFF the recorder before replacing the batteries. Removing the batteries while the

recorder is in use may corrupt the card. If you are recording into a file and the batteries run out, you will
lose your currently recorded file since the file header will not be written.  It is crucial to replace the batteries
when one hash mark in shown in the battery icon.

• Be sure to replace both batteries at the same time.
• Never mix old and new batteries, or batteries of different types and/or brands.
• If it takes longer than 1 minute to replace dead batteries, you may have to reset the time when you load

new batteries.
• Remove the batteries if you are not going to use the recorder for an extended period of time.

Installing Batteries
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An optional Ni-MH Rechargeable Battery from Olympus can
be used for the recorder.

1 Lightly press down on the arrow and slide the
battery cover open.

2 Insert Ni-MH Rechargeable Battery Pack,
observing the correct polarity.

3 Close the battery cover completely.

1

2

3

The battery needs to be charged when you use the recorder
for the first time after purchase (�P.15).

Recharging battery
The battery indicator on the display changes as the battery
loose power.

  →    →    →  

When  appears on the display, charge the battery as soon
as possible.
When the battery is too weak, the recorder shuts down and
“BATTERY LOW” appears on the display.

..............................................................................................................................................................

Notes
• The Olympus Ni-MH Rechargeable Battery Pack (BR402) is sold separately.
• Removing the battery pack while the recorder is in use may corrupt the file. If you are recording into a file

and the battery run out, you will lose your currently recorded file since the file header will not be written.  It
is crucial to charge the battery once you see only one hash mark in the battery icon.

• Remove the battery pack if you are not going to use the recorder for an extended period of time.

Ni-MH Rechargeable Battery Pack (BR402) (Optional)

Installing Batteries
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1 Connect the  optional AC adapter (A511/D-
7AC) or USB cable to the cradle.
For connection procedures, see P.57.
When using the adapter for charging, connect the
power plug to the charger’s AC connector.

2 Turn ON the recorder and set it vertically
in the cradle.
CHARGE indicator lamp glows red and the charging
starts.
The lamp goes out when the charging is complete.

..............................................................................................................................................................

Notes
• The Olympus AC adapter (A511/D-7AC) is sold separately.
• Charge the battery often for first few uses. Battery performs better after several full charge/discharge cycles.
• Ni-MH battery pack (BR402) is only chargeable with the Olympus AC adapter A511 or D-7AC.
• If you charge the battery right after charging is complete, it will take only few minutes to charge the battery.
• The PC must be ON when charging battery via the USB cable connection.
• Charging battery via the USB cable connection may not be successful depending on the power supply

capacity of your PC. Use the AC adapter instead.
• If you change the recorder to AUDIO device while charging battery only via the USB cable connection, charging may stop.
• Do not set or remove the recorder from the cradle while it is in operation.
• You can charge the battery while the recorder is in operation.

Charging Battery
You can charge the Ni-MH Rechargeable Battery Pack (BR402) in the recorder when you set the recorder
in the cradle. The battery is usually shipped partially charged. You need to charge the battery before first
use.

AC
connector

The plug type varies
depending on the
country where sold.

AC adapter

AC cable

A511/D-7AC (Optional)

CHARGE
indicator lamp

AC cable
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..............................................................................................................................................................

Notes
This charger is designed to fully charge batteries regardless of their energy level. However, for best
results when charging newly purchased batteries or batteries that have not been used for a long
time (more than one month), It is recommended to fully charge the batteries, then discharge them.
Repeat two or three times.
• When you dispose dead batteries always observe the laws and regulations regarding the disposing of such items.
• If Ni-MH rechargeable batteries are not fully discharged, protect against short-circuiting (e.g. by taping

the contacts) before disposing.

For customers in Germany
Olympus has a contract with the GRS (Joint
Battery Disposal Association) in Germany to
ensure environmentally friendly disposal.

Discharging

Batteries self-discharge while they are not in use. Be sure to charge them regularly before use.

Battery life

Charging and discharging are possible for approximately 500 times depending on usage.

Operating temperature

Batteries are chemical products. Battery efficiency may change even when operating within
the recommended temperature range, but this is not a malfunction.

Recommended temperature range for use

Discharging (when using appliance): 0°C - 50°C/32°F - 122°F
Charging: 0°C - 40°C/32°F - 104°F
Storage: –20°C - 30°C/–4°F - 86°F

Using the batteries outside the above temperature range may result in declining efficiency
and shorter battery life.
In order to prevent battery leakage or rust, remove the batteries from the products when you
will not be using them for a long time, and store them separately.

Information Regarding Rechargeable Batteries
These batteries are exclusively for use with Olympus voice recorder DS-3300. Never use them
in combination with other equipment.



1

17

Turning ON the Recorder
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With the battery charged in the recorder and the card
inserted properly, the recorder is ready to work.
While the power switch on the back of the recorder is in
the OFF position, none of the buttons or switch on the
recorder will be active. Slide the power switch to the ON
position to activate the recorder.

Power Save Mode

When the recorder is ON but not in use for 10 minutes, by default, it will switch to power save
mode automatically. To reactivate the recorder again, press any of the buttons on the recorder.
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CUSTOM Button (Programmable)
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The CUSTOM button can be assigned two kinds of functions by being pressed in different
ways. By default, the button is programmed on PRIORITY for both ways:

The following functions can be assigned to CUSTOM button.

- DISPLAY button
- Recording Mode setting button
- Microphone Sensitivity setting button
- VCVA setting button
- PRIORITY setting button

Dealer Option Items

For details on the functions and operation
of dealer optional items, consult your
Olympus dealer.

Some additional options can be set by your Olympus Professional Dealer.
These additional and customisable options are as follows:

� Setting for “beep” sound.
� Setting for NEW button operation.
� Setting for REC button operation.
� Setting for Splash screen.
� Adding/removing of user defined fields.
� Switching the display languages.
� Changing the number of folders.
� Assigning functionality to CUSTOM button.
� Assigning functionality to the foot switch.
� Setting time for Power save mode.
� Setting to lock the file automatically on completion of recording.
� Setting for intervals of acceleration when using CUE and REV.
� Setting to select the AUTHOR ID when the recorder is turned on.

CUSTOM
button
(Programmable)

Default

PRIORITY button

Operation

Press the CUSTOM button.

Press and hold the CUSTOM button.
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Setting the correct time and date on the recorder is very important since every file recorded on
the recorder will have the date and time information as part of the file header. This will simplify
the file management aspects later on.

The hour indicator will flash automatically when you load batteries before using the
recorder for the first time, or after the recorder hasn’t been used for a long time.
Proceed from step 1.

1 Set the hour.
1 Press the FF button or REW button to

set the hour.
2 Press the REC button to accept the hour.
• You can choose between 12 and 24 hour

display by pressing the CUSTOM button
while setting the hour and minute.

Example: 5:45 P.M.

5:45 PM ←→ 17:45
(Initial setting)

2 Set the minute.
1 Press the FF button or REW button to

set the minute.
2 Press the REC button to accept the

minute.

3 Set the year.
1 Press the FF button or REW button to

set the year.
2 Press the REC button to accept the year.
• You can choose a different date format by

pressing the CUSTOM button while setting
the date.

Setting Time/Date (TIME&DATE)
S

ettin
g

 T
im

e/D
ate (T

IM
E

&
D

A
T

E
)

FOLDER/MENU button
(accepts a choice and moves on to
the next item)

FF/REW
button
(alters a choice)

CUSTOM
button
(switching
the data
displayed)
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1
Example: March 14, 2005

3M 14D 2005Y (Initial setting)

↓
14D 3M 2005Y

↓
2005Y 3M 14D

4 Set the month.
1 Press the FF button or REW button to

set the month.
2 Press the REC button to accept the month.

Changing the Time/Date

5 Set the day.
1 Press the FF  button or REW button

to set the day.
2 Press the REC button to accept the

day’s date.

........................................................................
Notes
• If you press the STOP button during the setup

operation, the recorder will save the items that
were set to that point.

• You can set the time and date from your PC using
DSS Player software (� P.50).

1 Press and hold the FOLDER/MENU
button for 1second or longer.
The menu appears (� P.37).

2 Press the FF or REW button until
“TIME&DATE”  in SUB MENU flashes
on the display.

3 Press the REC button.
Time/Date screen appears. The hour
indicator flashes, indicating the start of the
Time/Date setup process.
Follow the same steps starting at step 1 in
“Setting Time/Date” (� P.19).

4 Press the FOLDER/MENU button to
close the menu.

S
ettin

g
 T

im
e/D

ate (T
IM

E
&

D
A

T
E

)

2

1,4

3

Setting Time/Date (TIME&DATE)
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Inserting and Ejecting a Card

Inserting a Card

1 Slide the card cover lock in the direction
indicated by the arrow.
The card cover is unlocked and the message “CARD COVER
IS OPEN” appears on the display. When this message
appears, the power is switched off automatically.

2 Face the card the correct way and insert it into
the card slot as shown in the diagram.
• Insert the card keeping it straight.

• The card stops with a click when it is inserted all the way.

• Inserting the card the wrong way or at an angle could
damage the contact area or cause the card to jam.

• If the card is not inserted all the way, data may not be
written to the card.

3 Close the card cover securely.

Card inserted fully into the slot
The message “PLEASE WAIT” on the display flashes for
seconds.

Card not inserted fully into the slot
When the card cover is closed, the message “INSERT
CARD” on the display flashes for a few seconds. Pressing
any button will sound beeps* and flash the message
“INSERT CARD” again.

* When the system sounds are enabled.

1

2

3
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..............................................................................................................................................................

Notes
• If an unformatted card is inserted, the recorder automatically displays the menu to menu format option (�

P.47).
• Never use any card in the recorder unless it has been formatted on this unit or on a CAMEDIA series Olympus

digital camera (� P.47).
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Ejecting a Card

1 Make sure the recorder is STOP mode.

2 Slide the card cover lock in the direction
indicated by the arrow.
The card cover is unlocked and the message “CARD
COVER IS OPEN” appears on the display.
The power is switched off automatically.

3 Push the card inward to unlock it, and let it
eject partially.
The card is visibly out of the slot and can be removed safely.

4 Hold the card straight and pull it out.

In
sertin

g
 an

d
 E

jectin
g

 a C
ard

Inserting and Ejecting a Card

..............................................................................................................................................................

Note
Releasing your finger quickly after pushing the card inward may cause it to eject forcefully out of the slot.
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By default, the recorder has five folders, A, B, C, D, E and you can select folder by
pressing the FOLDER/MENU button. These five folders can be selectively used to distinguish
the kind of recording; for example, Folder A might be used to store private information, while
Folder B might be dedicated to holding business information. You can use your DSS player to
change a folder name (� P.67). Up to 199 messages can be recorded per folder.
All recordings made in any of the folders will be in Digital Speech Standard (DSS) format. By
default, the RECORD function is configured to record at the current position (overwrite). However,
that can be changed to any of the following settings:
• Append: Appends the recording to the end of the current file.
• Insert: Inserts the recording at the current position in the file.
• Overwrite: Overwrites the recording starting at the current position in the file.

1 Press the NEW button to create a
new file.
a Current recording mode
b New file number
c Selected Author ID

2 Press the REC  button to start
recording.
The record/play indicator lamp glows red.
Aim the microphone at the sound source.
d Current recording time
e Remaining recording time

3 Press the STOP button to stop
recording.
If you want to append additional recordings
to the same file, press the REC button again.

New Recording
Create a new file to record in.

4H33M12S
REMA I N :

NEW  F I LE
AUTHOR  A 

a
b

c

AUTHOR  A 
00M05S

4H33M07S
d
e3

1
2
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Notes
• A beep will sound when the remaining recording time reaches 60 seconds, 30 seconds, and 10 seconds

while recording.
• “MEMORY FULL” or “FOLDER FULL” will be displayed when the memory or folder capacity is full. Delete

any unnecessary files before recording any further (� P.33) or transfer dictation files to your computer
using DSS Player Software (� P.58).

• You cannot select a different recording mode (SP or LP) than that of the original file when appending
recording.

Review Recording
Press the REW button while recording, and release it when you want to start playing a file.
The recorder plays up to the end of file, then stops.
You can overwrite or append additional recordings in the same file from that point.

Pause

Press the REC button while recording.

➥ “REC PAUSE” will flash on the display.
• The recorder stops when it has been left paused for 10 minutes or longer.

Resume Recording

Press the REC button again.

➥ Recording will resume at the point of interruption.
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1 Select and play the file you want to
overwrite.
Stop playback at the starting point of
overwrite.

2 Press the REC  button to start
overwriting.
The record/play indicator lamp glows red.

3 Press the STOP button to stop
overwriting.

Overwrite Recording
You can overwrite a previously recorded file from any point within the file.
Note that the overwritten recordings will be erased.

14M00S

AUTHOR  A 
10M25S

1
3

2

R
eco
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..............................................................................................................................................................

Note
You cannot select a different recording mode (SP, LP) than that of the original file before overwrite recording.
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2 1 Select and play the file you want to
insert an additional recording into.

2 While playing the file, press the
FOLDER/MENU button to insert an
additional recording.
“INSERT ?” appears on the display.

3 Press the REC button to start
inserting an additional recording.
The record/play indicator lamp glows red.
“INSERT REC” and the remaining
recording time will alternate on the display.

4 Press the STOP button to stop
inserting the additional recording.

Insert Recording
Additional recording can be inserted into previously recorded file.

AUTHOR   A
00M10S

02M25S
INSERT  ?

AUTHOR   A
00M12S

I NSERT  REC

R
eco

rd
in

g

Recording

2

1
4

3

AUTHOR  A 
00M11S

4H33M06S

..............................................................................................................................................................

Notes
• The recording time and date of the file is updated to the time and date of the inserted recording.
• You cannot select a different recording mode (SP, LP) than that of the original file before inserting.
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Microphone Sensitivity (MIC SENSE)
Microphone sensitivity is adjustable to meet recording needs.

1 Press and hold the FOLDER/MENU
button for 1 second or longer.
The menu appears (� P.37).

2 Press the FF or REW button until “MIC
SENSE” flashes on the display.

3 Press the REC button.
The microphone sensitivity setup process
begins.

4 Press the FF or REW button to choose
between “CONF.” and “DICT.”.
CONF. : High-sensitivity mode that records

sounds in all directions.
DICT. : Low-sensitivity mode suited for

dictation.

5 Press the REC button to select the
option.

6 Press the FOLDER/MENU button to
close the menu.

2,4

1,6

3,5
SUB MENU
EXIT

REC MODE
MIC SENSEMIC SENSE

CONF.CONF.
DICT.

MIC SENSEMIC SENSE

..............................................................................................................................................................

Note
If you want to record clear or noise-free dictation, select DICT mode and place the microphone 5 to 10 cm
(2 to 4 inches) from the source.
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Recording Modes (REC MODE)
The recording mode can choose between SP (standard recording) and LP (long-term recording).

1 Press and hold the FOLDER/MENU
button for 1 second or longer.
“REC MODE” will be displayed on the
screen (� P.37).

2 Press the REC button.
The recording mode setup process begins.

3 Press the FF or REW button to
choose between “SP” and “LP”.

4 Press the REC button to select the
option.

5 Press the FOLDER/MENU button to
close the menu.

EXIT

REC MODEREC MODE
VCVA

MIC SENSE

SP
LP

REC MODEREC MODE

3

1,5

2,4

..............................................................................................................................................................

Note
Choose SP mode for recording meetings or lectures with crisp clarity.
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When the microphone senses that sounds have reached a preset actuation volume level, the built-in Variable
Control Voice Actuator (VCVA) starts recording automatically, and stops when the volume drops below the actuation
level. The VCVA feature helps extending recording time and conserves the memory by turning off recording
during silent periods. This helps make the playback, with no lulls or dead space, more efficient and convenient.

Using the Variable Control Voice Actuator (VCVA)

1 Set the VCVA in the menu to ON (� P.37-
38).

2 Press the REC button to start recording.
When the sound volume is lower than the preset
actuation sound level, recording automatically stops after
1 second approximately, and “STANDBY” flashes on the
display. The record/play indicator lamp glows when
recording starts and flashes when recording pauses.

Adjust the Start/Stop Actuation Level

1 Press the FOLDER/MENU button during
recording.
The VCVA level screen is displayed.

2 Press the FF or REW button to adjust the
actuation level.
The VCVA level can be set to any of 15 different
values. The higher the value is, the more sensitive
the recorder can react to sounds. At the highest
value, even the faintest sound will activate recording.
The VCVA actuation level can be adjusted according
to the ambient (background) noise.
a Start level (varies according to the sound

volume being recorded)
b Level meter (moves to the right/left according

to the set level)

AUTHOR   A
1H25M01S

STANDBY

AUTHOR   A
1H25M01S

VCVA LEVEL 05a
b

..............................................................................................................................................................

Notes
• The start/stop actuation level also varies depending on the selected microphone sensitivity mode (� P.27).
• To ensure successful recordings, prior testing and adjustment of the start/stop actuation level is recommended.
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Hands-free Recording
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The recorder can be used as a hands-free recording device. To setup the recorder for hands-
free operation, connect the optional Olympus foot switch (RS25/26) to the back of the cradle
and place the recorder in the cradle as shown in the diagram below.

The default settings of the foot switch functions
are as follow:

It is possible to monitor your recording by listening to the
recording while recording is in progress. Insert the
earphone plug into the earphone jack and use the
VOLUME button to control the volume level.

Recording Monitor

Default settings

VOLUME
(+) / (–)
button

Switch

FF

LISTEN

REW

Press

NEW

–

–

Press and hold

–

REC

REV

Release

–

STOP

PLAY

..............................................................................................................................................................

Note
Insert the plugs to the end as shown in the illustration when inserting the earphone or external microphone.

..............................................................................................................................................................

Notes
• The Olympus foot switch (RS25/26) is sold separately.
• Make sure the recorder is STOP mode before connecting it to the cradle for hands-free recording.
• To record with better quality using the hands-free recording function, set the microphone sensitivity to

"CONF." mode, or use an external microphone.



31

2

Playing
P

layin
g

1 Select the file, then press the PLAY
button to start playback.
The record/play indicator lamp glows
green.
a Current playback time
b Total recording time of the file being

played

2 Press the VOLUME (+) or VOLUME
(–) button to adjust the volume.
The display shows the volume level. You
can choose between 0 to 30.

3 Press the STOP button at any point
you want to stop the playback.

You can start playing a file at any point.

AUTHOR A
00M05S

LENGTH :
27M58S

a

b

1
3

2
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• If you press the FF button once while fast-forwarding or twice while stopped, the recorder will stop at the
end of the file (F.SKIP).

• If you press the REW button once while rewinding or twice while stopped, the recorder will stop at the
beginning of the file (B.SKIP). If the REW button is pressed within 2 seconds, the recorder skips to the
beginning of the previous file.

Playback
functions
Fast
Forward
(FF)

Rewind
(REW)

Cue
(CUE)

Review
(REV)

Operation

Press the FF button once while stopped.

Press the REW button once while stopped.

Hold the FF button while stopped or playing a file.

Hold the REW button while stopped or playing a file.

How to Cancel

Press the PLAY button.
➥ The recorder starts the operation of

the set position.

Release the FF button.

Release the REW button.

Playing

Playback functions



33

2

E
rasin

g
Erasing

1 Select the file you want to erase.

2 Press the ERASE button.
“FILE ERASE ?” flashes on the display for
approximately 8 seconds.

3 Press the ERASE button once more
while “FILE ERASE ?” is flashing.
The display changes to “FILE ERASE !” and
erasing will start.

“ERASE DONE” is displayed when the file is
erased. File numbers will be reassigned
automatically.

FOLDER   A

F I LE
ERASE  ?

FOLDER   A

F I LE
  ERASE  !

FOLDER   A

ERASE DONE  

{
Erasing a File
Erasing or deleting a file from any of the folder on the recorder is a very simple process.

2,3

..............................................................................................................................................................

Notes
• If the ERASE button is not pressed within the 8 seconds after “FILE ERASE?” starts flashing, the recorder

will revert to the stop status.
• An erased file cannot be restored.
• Locked files cannot be erased (� P.39).
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Erasing
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Erasing All Files in a Folder
All files in a folder can be erased simultaneously, except for locked files (� P.39).

1 Select any file in the folder, then
press and hold the ERASE button for
3 seconds or longer.
“ALL ERASE ?” flashes on the display for
approximately 8 seconds.

2 Press the ERASE button once more
while “ALL ERASE ?” is flashing.
The display changes to “ALL ERASE !” and
erasing will start.

“ERASE DONE” is displayed when the files
are erased. Any locked files in the folder will
be reassigned new file numbers in ascending
order.

FOLDER   A

 ALL ERASE ?

FOLDER   A

 ALL ERASE !

FOLDER   A

ERASE   DONE

{

1,2

..............................................................................................................................................................

Notes
• If the ERASE button is not pressed within the 8 seconds after “ALL ERASE ?” starts flashing, the recorder

will revert to the stop status.
• The erasing process may take up to 10 seconds. Do not interrupt this process! Data will be destroyed.
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Partially Erasing a File
You can erase a selected file in part.

AUTHOR   A
45M02S

PART I AL
ERASE 

AUTHOR  A
45M00S

LENGTH :
1H55M25S

1 Start playback the file you want to
erase partially.

2 Press the ERASE button at the point
to start erasing.
While playback continues, “PARTIAL
ERASE” and the file length will alternate
on the display.

AUTHOR  A
5M01S

START
ERASE

AUTHOR  A
45M32S

END
ERASE

3 Press the ERASE button at the point
to end erasing.
The erase starting point (time) set in step
2 and the ending point (time) set in this step
will alternate on the display for 8 seconds.

1
2,3
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4 Press the ERASE button to confirm
erase.
The display changes to “PARTIAL ERASE!”
and erasing will start.

When “ERASE DONE” appears on the display,
partial erase is complete.

AUTHOR   A
 5M01S

ERASE DONE

Erasing

4

AUTHOR   A
 5M01S

PART I AL
ERASE !

{

..............................................................................................................................................................

Notes
• If the ERASE button is not pressed within the 8 seconds after “START” or “END” starts flashing, the

recorder will revert to the stop status.
• An erased file cannot be restored.
• Locked files cannot be partially erased (� P.39).
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REC MODE

MIC SENSE

EXIT

SUB MENU

VCVA

LOCK

BEEP

FORMAT

EXIT

BACKLIGHT

TIME&DATE

CONTRAST

USB CHARG.

Menu List

Select SP or LP mode (�P.28).

Time/Date setting. Hour, minute, year, month
and day (�P.19).

Recorder formatting (�P.47).

LCD contrast adjustment. Select the level from
1 to 12.

System sounds setting. Select ON (enabled)
or OFF (disabled).

Backlight setting. Select ON (enabled) or OFF
(disabled).

Press and hold the FOLDER/MENU button for 1 second or longer.

Press the FF
button or REW
button.

M
en

u
 L

istVCVA setting (�P.29). Select ON (enabled)
or OFF (disabled).

Microphone sensitivity setting. Select between
CONF (high-sensitivity mode) or DICT (low-
sensitivity mode) (�P.27).

Press the
REC button.

Returns to the MENU.

Switches to the SUB MENU.

Exit MENU and return to STOP mode.

Locking files setting (�P.39). Select ON
(locked) or OFF (unlocked).

SUB MENU

MENU

USB charge setting. Select ON (enabled) or
OFF (disabled).

..............................................................................................................................................................

Notes
• If you press the STOP button or FOLDER/MENU button during a menu setup operation, the recorder will stop

and apply the items that were set to that point.
• The recorder will stop if you leave it idle for 3 minutes during a menu setup operation, when a selected item is

not applied.
• You can set the time and date on the recorder from your PC using DSS Player software (� P.50).
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Learning to Use the Menu
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To navigate through the different options in the MENU, use the MENU List flow chart (� P.37)
and the following steps to modify or change any settings.

1 Press and hold the FOLDER/MENU button for 1
second or longer.
The menu appears (� P.37).

2 Press the FF or REW button to highlight a menu
item you want to modify/change.

3 Press the REC button to select that menu item.
The possible options for the menu item will be in view.

4 Press the FF or REW button to highlight an option
or setting.

5 Press the REC button.
The highlighted option will be selected and the new setting
saved.

6 Press the FOLDER/MENU button to close the
menu.

2,4

1,6

3,5
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Locking Files (LOCK)
The file lock feature is very useful to protect important data from accidental erase. Locked files
are never erased except when the card is formatted (� P.47).

ON
OFF

FOLDER   A
a

L
o

ckin
g

 F
iles (L

O
C

K
)

FORMAT

LOCKLOCK
BEEP

1 Select the file you want to LOCK,
press and hold the FOLDER/MENU
button for 1 second or longer.
The menu appears (� P.37).

2 Press the FF or REW button until
“LOCK” in SUB MENU  flashes on the
display.

3 Press the REC button.
The file locking setup process begins.

4 Press the FF or REW button to
choose between “ON” and “OFF”.
ON: Locks the file and prevents it from

being edited or erased.
OFF: Unlocks the file and allows it to be

edited or erased.
a Erase lock indicator

5 Press the REC button to select the
option.

6 Press the FOLDER/MENU button to
close the menu.

2,4

1,6

3,5

..............................................................................................................................................................

Notes
• You cannot append, overwrite, or insert recordings into locked files (� P.23).
• You cannot set index marks in locked files (� P.40).
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Index marks can be placed in a file during recording or playback to provide a quick and easy to
identify important sections in the file.

Setting an Index Mark

1 Press the INDEX button during
recording or playback to set an index
mark.
An index number appears on the display.

Locating an Index Mark

2 Hold the FF or REW button while
playing a file.
The recorder stops for 1 second when it
reaches the index mark.

Clearing an Index Mark

3 Locate the index mark you want to
clear.

4 Press the ERASE button while the index
number appears for approximately 2
seconds on the display.
The index mark is erased.

In
d

ex M
arks

AUTHOR  A
12M05S

I NDEX  08
SET

AUTHOR  A
12M05S

I NDEX  08
CLEAR

Index Marks

24

1

..............................................................................................................................................................

Notes
• Up to 16 index marks can be set in a file. Attempting to set more index marks will cause “INDEX FULL” to

appear on the display.
• Index marks cannot be set or cleared in a locked file (� P.39).
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1 Use the DISPLAY (CUSTOM) button.

The LCD display will switch view every time the DISPLAY
(CUSTOM) button is used.

While in Stop or Playback Mode
When using DISPLAY (CUSTOM) button, the recorder will cycle
through 1 to 7. If there is no file, only 5, 6 will display instead.

AUTHOR  A
00M00S

LENGTH :
2H27M58S

AUTHOR  A
00M00S

REC   DATE :
3M16D2005Y

AUTHOR  A
00M00S

REC   TIME :
3M16D   12:56 A

M

AUTHOR  A
00M00S

COMMENT :_ _ _ _

AUTHOR  A
00M00S

REMAIN :
1H50M12S

AUTHOR  A
TIME&DATE :

3M16D2005Y
      12:00AM

}

{
{

{
{

1 File length
Shows how long a file is.

2 Time stamp
Shows the year, month,
and date that the file was
recorded.

3 Time stamp
Shows the time that the file
was recorded.

7 Current time and date
Shows the current time and
date. (During the playback
operation, the “TIME & DATE”
or the counter appears.)

5 Memory remaining
Shows the remaining recording
time.

4 File comment*
Shows a comment added to
the file. (If there is no
comment, “----” will appears.)

* If a comment contains many
characters, it will scroll horizontally
to display the complete comment.

LCD Display Information
L

C
D

 D
isp

lay In
fo

rm
atio

n

{
6 Work type ID

Shows the selected Work Type
ID.

1

AUTHOR  A

WORKTYPE :
00M00S

SURGICAL

Before using the DISPLAY function, it should be programmed to CUSTOM button.
The LCD screen on the recorder can display 7 different formats of information by using the DISPLAY
(CUSTOM) button. This helps review and confirm different recorder settings and file information.
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LCD Display Information

AUTHOR  A
25M01S

2H33M25S

L
C

D
 D

isp
lay In
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n

While in Record Mode
1 Recording level meter

Displays the sound input
level graphically and the
remaining time available for
recording in countdown
mode.

AUTHOR  A 
00M05S

4H33M07S

AUTHOR  A

E F

25M01S
2H33M25S

2 Remaining memory bars
Displays the remaining time
available for recording in bar
mode and countdown mode.

While in Overwrite Record Mode

1 Recording level meter
Displays the sound input
level graphically, the current
time and the length of the
file.

AUTHOR   ID
10M25S
14M00S

AUTHOR   ID
10M25S
14M00S

E F

2 Remaining memory bars
Displays the remaining time
available for recording in bar
mode, and the current time
and length of the file.

AUTHOR  A

E F

25M01S
2H33M25S

While Recording in VCVA Mode

1 VCVA recording level
meter
Displays the sound input
level graphically and the
remaining time available for
recording in countdown
mode.
(“STANDBY” appears if the VCVA actuation
level isn’t reached.)

2 Remaining memory bars
Displays the remaining time
available for recording in bar
mode and countdown mode.

AUTHOR   ID
1H25M01S

INSERT  REC

AUTHOR  A
1H25M01S

I NSERT  REC
E F

While in Insert Record Mode

1 Recording level meter
Displays flashing “INSERT
REC”, the sound input level
graphically, and the current
recording time.

2 Remaining memory bars
Displays flashing “INSERT
REC”, the remaining time
available for recording in bar
mode, and the current
recording time.
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By default, CUSTOM button is programmed with PRIORITY function.
You can set a priority level on each file recorded. You can choose between high (  ) and
normal (no indication). The default is normal.

1 Select the file.

2 Press or hold the PRIORITY
(CUSTOM) button to choose the
priority level.

: High level
No indication: Normal level.
a Priority level indicator

To Set a Priority Level on an Existing File

AUTHOR  A

LENGTH :
00M00S

27M58S

a

Setting Priority Levels

To Set a Priority on a New File

AUTHOR  A
NEW  F I LE

REMA I N:
2H33M12S

AUTHOR  A
00M00S

LENGTH :
27M58S

AUTHOR  A
NEW  F I LE

REMA I N:
2H33M12S

S
ettin

g
 P

rio
rity L

evels

12

2
1

1 Press the NEW button.
A new file is created.

2 Press or hold the PRIORITY
(CUSTOM) button to choose the
priority level.

: High level
No indication: Normal level.

..............................................................................................................................................................

Note
Priority level cannot be changed on a locked filed (� P.39).
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Setting Job Data

To operate the AUTHOR ID setting (when turn on the recorder), the recorder needs to be
additionally set to the dealer option item beforehand.
Every file recorded on the recorder will include the Author ID and Work Type as part of its
header information. To create multiple Author IDs and Work Types on the recorder, use the
bundled DSS Player software to create and upload a Job Data list (list of Author IDs and Work
Types) to the recorder.
By default the Author ID is set to “DS3300”.

1 Turn ON the recorder.
When more than one Author ID exist
on the recorder, the ID list will be
displayed.

2 Press the FF or REW button to
select the Author ID that you
want to assign to the recorder
from the ID list.

3 Press the REC button to set the
ID.
All recordings made by the author
during the session will include the set
ID as part of the header information.

Setting an Author ID

ID 1

ID 2

ID 3

ID10

 ID  List

AUTHOR   A
AUTHOR   B
AUTHOR   C
AUTHOR   D

S
ettin

g
 Jo

b
 D

ata 1

2
3
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Setting a Work Type

 Type  List
Type 1

Type 2

Type 3

Type 10

WORKTYPE   A
WORKTYPE   B
WORKTYPE   C
WORKTYPE   D

S
ettin

g
 Jo

b
 D

ata

2
3
1

1 Press the NEW button while in
STOP mode.
When more than one Work Type ID
exist on the recorder, the Work Type
ID list will display.

2 Press the FF or REW button  to
highlight a Work Type from the
Work Type ID list.

3 Press the REC button to select
the Work Type.
All recordings made with the new Work
Type ID will have the new Work Type
as part of the header information.
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1
1 Press the NEW button while in

STOP mode.
When programmed into the recorder, the
Option Item ID displays.

2 Use the alphanumeric characters
set displayed to set the Option Item
ID.
Characters that can be entered are from 0
to 9, from A to Z, and _.

Entering method
Press the FF/REW button:

Navigate through the character set.
Press the REC button:

Enter the highlighted character and go
on to the next character.

Press and hold the REC button:
Finish entering ID.

Press the ERASE button:
Erase the characters being entered.

If multiple Option Items are programmed
into the recorder, each Option Item ID is
entered in the same way described above.
When entering the final ID is done, the
recorder switches to NEW mode.

Setting Option Item

PAT I ENT  NO
7_

34567890AB

The recorder can be programmed with additional user defined fields called Option Items.

..............................................................................................................................................................

Notes
• Each Option Item ID field can accept up to 20 characters maximum.
• If more than one Work Type ID exist on the recorder, the Option Item ID displays after determining the

Work Type.
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Formatting the Card (FORMAT)

1 Press and hold the FOLDER/MENU
button for 1 second or longer.
The menu appears (� P.37).

2 Press the FF or REW button until
“FORMAT” in SUB MENU flashes on
the display.

3 Press the REC button to select
“FORMAT”.
The formatting process is selected.

4 Press the FF or REW button to
highlight the “START” option.

5 Press the REC button to confirm
“START” selection.
“DATA WILL BE CLEARED” appears for
approximately 2 seconds.

Cards that have been used on non-Olympus devices, or cards that are not recognized by the
recorder, must be formatted before they can be used with the recorder. The Olympus xD-
Picture Card delivered with the recorder is preformatted and ready for use.
To familiarize yourself with the formatting process, read the steps below.

 
FORMAT
EX I T
CONTRAST

CANCEL
START

DATA  W I LL
BE  CLEARED
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6 Press the FF or REW button again
to highlight the “START” option.

7 Press the REC button again to
initiate the formatting process.
Formatting begins and “FORMAT!” flashes
on the display.

“FORMAT DONE” displays when formatting
ends.

FORMAT
DONE

{
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SURE?
CANCEL
START

FORMAT!

6
7

Formatting the Card (FORMAT)

..............................................................................................................................................................

Notes
• The time required to format cards differs depending on the capacity of cards. For example, formatting

may take about 1 minute for 512 MB card. Do not interrupt the formatting process by opening the card
cover or the battery cover. Doing so will damage the data or card.

• When the card is formatted, all the stored data, including locked files, are erased.
• If an unformatted card is inserted, the recorder automatically displays the format option in the menu.
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Setting the HOLD switch to the HOLD position.
If you set the recorder to HOLD status by sliding the
HOLD switch in the direction of the arrow, the current
conditions will be preserved, and all buttons and switches
except the HOLD switch will be disabled. This feature is
useful when the recorder has to be carried in a bag or
pocket.
Remember to reset the HOLD switch when
using the recorder.

..............................................................................................................................................................

Notes
• The display will flash if the switch is moved to hold in the stop status. At this time, if any button is pressed

the clock display will flash for about 2 seconds, but will not operate.
• If the switch is moved to hold during playback (or recording), the playback (recording) status will stay and

cannot be operated.
(When playback has ended and the recording has ended due the remaining memory being used up, it will
be in the stop state.)
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The DSS Player is a fully featured software tool that provides a simple to use but sophisticated
method of managing your recordings. Some of the features of the DSS Player are:
• Automatic download and backup of recordings from the recorder to a PC.
• Automatic distribution of recordings by e-mail or FTP to transcriptionists or other users.
• Automatic retrieval of typed documents, via e-mail or FTP, linking the document to the recording.
• Allows you to manage and change settings on your recorder.

• Allows you to play and edit recordings on your PC.

• When used with the recorder connected to a PC, direct recording on the PC is possible.

D
S

S
 P

layer S
o

ftw
are

DSS Player Software

Precautions on using the recorder connected to a PC

� When you are downloading a file from
the recorder or uploading a file to the
recorder, do not remove the USB cable
even if the screen is indicating you can.
Data is still being transferred while the
record/play indicator lamp is blinking.
When removing the USB  cable, be sure
to follow the description in �P.56. If the
USB cable is removed before the drive
is stopped, data may not be
successfully transferred.

� On a PC, do not format the drive of the
recorder. Initialization is not successfully
achieved on a PC. For initialization, follow
the instructions in the menu screen of
the recorder (� P.37).

� Folder (directory) names displayed by
file management tools such as Explorer
attached to Microsoft Windows and
Finder attached to Mac OS are different
from the folder names settable with the
recorder or DSS player.

� If folders or files stored on the recorder
are moved or renamed by using a file
management tool such as Explorer or
Finder, the order of files may be
changed or files may become
unrecognizable.

� Data can be written or uploaded to the
recorder even though the attribute of
the recorder drive is shown as Read-
only by the operating system of the PC.

� As the noise may cause adverse effects
on electronic devices nearby the
recorder, unplug the earphone when
you connect the recorder to a PC.
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..............................................................................................................................................................

Notes
• Do not use the recorder as a USB Microphone/Speaker on Windows 98 as computer operation may

become unstable. (Use only with Windows 98SE or later versions of the OS.)
• To use the voice recognition function with the recorder, use Windows 98SE or later versions of the OS (� P.68-69).
• Macintosh version does not support voice recognition software.
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Operating Environment
Make sure that your computer meets the operating environment listed below. Please check
with your system administrator or your Olympus Professional Dealer.

PC:
Operating
System:

CPU:

RAM:

Hard drive
space:
Drive:

Sound card:

Browser:

Display:

USB port:
Audio I/O
terminals:

PC:

Operating
System:
RAM:

Hard drive
space:
Drive:

Display:

USB port:
Audio I/O
terminals:

IBM PC/AT compatible PC
Microsoft Windows 98/ 98SE/
Me/ 2000 Professional/ XP
Professional, Home Edition
Intel Pentium II class 333
MHz processor or faster
(Processor 500 MHz or faster
is recommended)
128 MB or more (256 MB or
more is recommended)
50 MB or more

2x or faster CD-ROM, CD-R,
CD-RW, DVD-ROM drive
Creative Labs Sound Blaster
16 or 100% compatible
sound card
Microsoft Internet Explorer
4.01 SP2 or later
800 x 600 pixels or more, 256
colors or more
One or more free ports
Microphone input and
earphone output or speaker

Power Mac G3 233 MHz
class processor or faster
iMac/ iBook/ eMac/ Power
Mac/ PowerBook
(The computer must support
a standard USB port.)
Mac OS 9.0-9.2.2/ 10.1-10.3

OS X
128 MB or more (256 MB or
more is recommended)
OS 9.x
64 MB or more (128 MB or
more is recommended)

50 MB or more

2x or faster CD-ROM, CD-R,
CD-RW, DVD-ROM drive
800 x 600 pixels or more, 256
colors or more
One or more free ports
Earphone output or speakers
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Installing DSS Player Software

1 Insert Olympus DSS Player CD
into the CD-ROM drive.
The installation program will start
automatically.
If the installation program does not start
automatically, browse your CD-ROM drive
and execute “setup.exe”.

2 The installation Language Selection
dialog box appears.
Select the desired language.

3 Register user information.
Enter your name, company name, and
license ID number (serial number).
The license ID number is printed on the
license ID card included inside the recorder
package.
Click the [Next] button. When a confirmation
dialog box appears, click the [Yes] button.

4 Proceed with the installation
according to the instructions on the
screen.

Before you connect your recorder to your PC, you must first install the DSS Player software.
Make sure to exit all running applications, eject the floppy disk if you are using one, and logon as
administrator if you are running Windows 2000/XP (Professional only) or Mac OS X on the network.

1 Insert Olympus DSS Player CD
into the CD-ROM drive.

2 Double-click the CD icon.
Select the folders named “Mac OS 9.x”
and “Mac OS X” and start up your OS.

3 Double-click the following icon.
Select the folder of which the language
is to be installed, and execute the
installation program in the folder.

4 Proceed with the installation
according to the instructions on the
screen.

..............................................................................................................................................................

Note
Never install DSS Player in Mac OS 9.x system, when using DSS Player with Mac OS X. The device
connected when using the classic environment may not be recognized.
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Uninstalling DSS Player Software

1 Exit DSS Player program.

2 Click the [start] button on the
taskbar.

3 Select [Add/Remove programs]
from the [Control Panel].
A list of installed applications is displayed.

4 Select [Olympus DSS Player Pro],
then click the [Change/Remove]
button.

5 Proceed with the uninstallation
according to the instructions on
the screen.
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..............................................................................................................................................................

Note
Uninstallation does not erase the stored dictation files.

1 Exit DSS Player.

2 Delete the Preferences file.
Delete the [DSS Preference] file in the
following location.
(OS X)
Macintosh HD : User : Library : Preferences
(OS 9.x)
Macintosh HD : System Folder : Preferences

3 Delete the Executable file.
Delete the [DSS Player for Mac] (OS 9.x)
/ [DSS Player] (OS X) file in the location
where you installed the file.
For OS X users, uninstalling has been
completed. For OS 9.x users, proceed to step 4.

4 Delete the Driver file.
Delete the following files in the following location.
System folder : Function Enhancement

[DSS 10USB Driver]
[DSS 10USB Shim]
[DSS 1USB Driver]
[DSS 1USB Shim]
[DSS FSUSB Driver]
[DSS FSUSB Shim]
[DSS USB Driver]
[DSS USB Shim]

5 Delete the Help file.
Delete the [DSS Player for Mac Help]
(OS9.x)/ [DSS Player Help] (OS X) file in
the following location.
System folder : Help
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• Click the [start] button, then select [All Programs], [Olympus
DSS Player], [Dictation Help].

• While DSS Player is running, select the [Help] menu,
[Contents].

• While DSS Player is running, press F1 on the keyboard.

• While DSS Player is running, select [DSS Player for Mac
Help] (OS 9.x)/ [DSS Player Help] (OS X) from the [Help]
menu.

Using Online Help
For information on the DSS Player usage and features, refer to the online Help.
To start online Help:
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elp

..............................................................................................................................................................

Note
Online Help is available after the DSS Player is installed.
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Connection to Your PC

1 Turn ON the recorder (� P.17).

2 Insert end A of the USB cable to
your PC’s USB port or USB hub.

3 Make sure the recorder has
stopped before attaching end b
of the USB cable to the terminal
port of the recorder.
If “REMOTE” is displayed on the
recorder, it indicates proper connections.

REMOTE

Once you connect the recorder to your PC, the recorder will
be powered through the USB cable. The batteries and/or
AC adapter will not be in use.

Be sure to install the DSS Player software before connecting the recorder to a PC. However, if
you do connect the recorder before or during the software installation, the “Add New Hardware
Wizard” appears. In this case, cancel the wizard by pressing the [Cancel] button in the wizard
screen and then install or continue the installation of DSS Player software.
You can directly connect the recorder’s USB terminal to your PC, or use the cradle included in
the package (desktop holder).

Connecting to Your PC Using the USB
Cable
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..............................................................................................................................................................

Notes
• NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If

you do, the data on the card will get destroyed.
• Some PCs and USB hubs may not supply sufficient power and the recorder fails to connect. Refer to your

PC User’s Manual regarding the USB port or USB hub on your PC.
• When using a USB hub to connect the recorder, always use a self-powered (AC adapter) USB hub.
• Make sure to push the cable connector all the way in. Otherwise, the recorder may not operate properly.
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Connection to Your PC
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Disconnecting from Your PC

1 Click the  on the task bar
located at the lower-right corner
of the screen. Click [Safely
Remove Hardware].
It will read [Stop USB Disk-Drive] for
Windows Me. The drive letter will differ
depending on the PC being used.

2 Disconnect the USB cable.

1 Move the icon of the recorder's drive displayed on desktop to trash box by
drag and drop.

2 Disconnect the USB cable.

..............................................................................................................................................................

Notes
• NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If

you do, the data on the card will get destroyed.
• Some PCs and USB hubs may not supply sufficient power and the recorder fails to connect. Refer to your

PC User’s Manual regarding the USB port or USB hub on your PC.
• When using a USB hub to connect the recorder, always use a self-powered (AC adapter) USB hub.
• Make sure to push the cable connector all the way in. Otherwise, the recorder may not operate properly.

Remove the Recorder from the Cradle
To prevent damage or loss of the data, confirm that the recording/playback indicator lamp of
this recorder is not on, and remove this recorder and USB connection cable from the cradle.
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1 Insert end A of the USB cable to your PC’s USB
port or USB hub.

2 Connect end b of the USB cable to the cradle.

3 Turn ON the recorder, then set the recorder in
the cradle.
If “REMOTE” is displayed on recorder, it indicates proper
connection.

Connecting to Your PC Using the
Cradle
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..............................................................................................................................................................

Notes
• Never touch the contact points at the bottom of the cradle, as that may cause bad connection.
• With a PC connected, the recorder cannot be operated with the foot switch (RS25/26). When connecting

the recorder to a PC via the cradle, remove the foot switch.
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Running DSS Player

By default, connecting the recorder to your PC, will start the application automatically.

Disabling automatic start

1 Right-click the Device Detector icon        in the System Tray in the lower right-
hand corner of the screen, then select “Settings startup application”.

2 Click [DSS Player Pro].
The check mark on [DSS Player Pro] disappears.

2 3
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Manual start

1 Start Windows.

2 Click the [start] button, then select [All
Programs].
All program menu will be displayed.

3 Select [Olympus DSS Player Pro], then
click [Dictation Module].

..............................................................................................................................................................

Note
If you connect the recorder before installing DSS Player, the “Add New Hardware Wizard” dialog box will
open. If this happens, click [Cancel] to exit the wizard, then install the DSS Player software.



59

4

1 Start your Macintosh.

2 Connect the recorder to your PC.
For cable connection instructions, see
“Connecting to Your PC Using the USB
Cable” (� P.55).

3 Double-click the [DSS Player for
Mac] (OS 9.x)/[DSS Player] (OS X)
folder.
The DSS Player (for Mac) folder opens.

4 Double-click DSS Player.
DSS Player for Mac (OS 9.x)/DSS Player
Plus (OS X) launches.

For the OS X users: “The user’s registration
screen” is displayed when first launched.

5 Register user information (OS X).
The user’s registration screen will be
displayed at the time of initial startup.
Please input the serial number.
Please see the seal attached to the CD-
ROM package included with the DSS
Player, for the serial number.
After the input has ended, click [OK] to
complete the registration.

3
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..............................................................................................................................................................

Note
The Mac version DSS Player does not have the automatic start function.
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Window Names
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1 Playback Control Bar
Provides the control buttons to play and stop
dictation files.

2 Dictation Tree View
Displays the directory structure of the DSS,
WAVE (Windows only) and AIFF (Macintosh
only)-format files stored on your PC’s hard disk.

3 Device Tree View
Displays the directory structure of the folders
in the recorder.

4 Dictation List View
Displays the dictation files in the folder selected
in 2 and 3.

1

4
2

3
1

4

2

3

* Main screen is displayed
when DSS Player is started
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There are 3 download options to transfer dictation files from the recorder to the PC:

• Download Selected Files

Download one or several dictation files to your PC.

• Download Folder X (X is any of the seven folders A to G)

Download all the dictation files in one folder.

• Download All

Download all the dictation files stored on the recorder to your PC.

The following is an explanation of “Download Selected Files”. For explanations of “Download
Folders” and “Download All”, refer to Online Help.

2 Select the dictation file.
Select the dictation file you would like to
download from the Dictation List View. To
select more than one file, hold either the
[Ctrl] or [Shift] key and select desired files.
The illustration shows that one dictation
file is selected.

Download Dictation Files from the Recorder

1

2
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1 Select the folder.
From the Device Tree View, select the folder that
contains the dictation file you would like to download.
The illustration shows that Folder A is selected.
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3 Download the dictation file.
From the [Download] menu, click
[Download Selected Files].

4 Download complete.
Do not disconnect the USB cable while
the record/play indicator lamp on the
recorder is flashing. Disconnecting the
USB cable when the recorder indicator
lamp is flashing will result in data loss or
corruption.

3
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You can change the download destination folder
by changing the folder properties in the Download
Tray. Right-click the folder and make the
necessary changes under [Properties].
To change the download options and filename
format, check the [Tools] menu, [Options].

..............................................................................................................................................................

Notes
• NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If

you do, the data on the card will get destroyed.
• Depending on the size of the dictation file and your PC, it may take some time to download the files.
• The downloaded files will be stored in the download tray folder that corresponds to the folder in the recorder.

(Example: A dictation file downloaded from Folder A will be stored in download tray A on your PC.)
• If a dictation file already exists on your PC with the same name, date and time recorded, the new file will

not be downloaded.

Download Dictation Files from the Recorder
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Playing a Dictation File

1 Select the folder.
Select the folder where the dictation
file resides.

2 Select the dictation file.
Select the dictation file to play from
the Dictation List View.

3 Play the dictation file.
Click the  (play) button in the
Playback Control Bar or double-click
the file.

DS33 0001.dss
Extension

File number ...... A serial number automatically assigned by the recorder.

Author ID...The ID that has been set on the recorder. The default ID is “DS3300”. The Author ID
can be modified with DSS Player (� P.66).

File Name Format
File names are assigned in the following manner.

Other playback control bar such as Rewind, Fast Forward, Stop, Speed Control, Volume Control,
Time Axis and Index Skip are also available on the Playback Control Bar.
The DSS Player can playback voice through the recorder speaker. The recorder must be
connected to the PC, and the USB Audio feature must be enabled on the recorder. See “USB
Microphone/USB Speaker” (� P.76).
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1 Select the folder.
Select the folder where the dictation file
to upload resides.

2 Select the dictation file.
Select the dictation file to upload from the
Dictation List View, then select [Download]
menu, then [Upload Files] or click the 
icon in the toolbar.

3 Select the destination upload
folder on the recorder.
When the folder list box appears,  select
the folder then click the [OK] button.

4 Upload complete.
Once the transmission screen closes and
the record/play indicator lamp on the
recorder is NOT, upload is completed. 21

Upload Dictation Files to the Recorder
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As a shortcut, you can drag and drop files
from the Dictation List View to the recorder’s
folders displayed in the Device Tree View.

3

DSS Player enables you to upload DSS dictation files from your PC to the recorder.

..............................................................................................................................................................

Note
NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If you
do, the data on the card will get destroyed.
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You can easily record on the PC directly using the recorder and the DSS Player. While the recorder is
connected to the PC with the USB cable, the Remote Dictation window in the DSS Player allows you to
create a new recording or edit an existing recording. The recorder will act as a sophisticated microphone
with the buttons controlling the recording or editing process. See the Online Help for details.

Direct Recording/Editing on PC
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Editing existing files

1 From the DSS Player main
window, select the file you want
to edit from the Dictation List View.

2 Click the [File] menu, then select
[Edit File], or click the  icon.
[Remote Dictation] window appears.

3 Edit the recording using the
recorder buttons.
You can use the mouse connected to your
PC and the Record and Playback controls
to edit recordings.

Recording a new file

1 From the DSS Player main window,
click the [File] menu, then select
[New File], or click the  icon.
[Remote Dictation] window appears.

2 Press the  (record) button in
the [Remote Dictation] window or
press the REC button on the
recorder to start recording.

3 Press the  (stop) button or
press the STOP button on the
recorder to stop recording.

..............................................................................................................................................................

Notes
• If you open the [Remote Dictation] window while the recorder is connected, the function of the recorder is

changed to Audio device from Storage device automatically. The recorder as AUDIO device is not displayed
as a removable drive on your PC. Closing the [Remote Dictation] window and returning to the main
screen will switch the recorder back to storage class device displayed as a removable drive.

• You cannot edit WAV files.
• For DSS Player for Mac, the editing functions are partially limited.
• The maximum recording time per file is 99 hours.
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User ID can be uploaded to the recorder using the DSS Player. Up to 10 IDs can be uploaded
to the recorder.

Changing User ID (Author ID)

1 From the main window, click the
[Download] menu, then select [Create &
Send Job Data]. The [Create & Send Job
Data] window appears.
Enter your user ID in the field indicated by the
arrow.

2 Click the [Transfer] button.
The new user ID will be transferred to the
recorder. 1 2
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..............................................................................................................................................................

Note
NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If you
do, the data on the card will get destroyed.
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Changing a folder name in the software
You can change a folder name in the Dictation List View using the [Rename Folder] command
from the [File] menu. A folder name can be up to 20 characters long and cannot use \ /
:*?"<>|.

Changing a folder name in the recorder
Right-click the folder in the Device Tree View to be renamed, select the [Rename Folder]
and input the new folder name.

The name of the folder on the recorder will be updated with the new folder name automatically.
Device Window folder names consist of a string of 8 or fewer alphanumeric characters.

Changing a Folder Name

You can use your DSS Player to create/edit comments, then transfer them from the PC to the
recorder. You can also edit file comments imported from the recorder to a PC.

Click the [Tools] menu, then select [Edit Comment].
File comments can use up to 100 alphanumerical characters and symbols.

Editing File Comments
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The folders in the software and recorder can be renamed to reflect the type of recording they
will contain. For example, Folder A might be used to store private information and thus be
renamed PRIVATE, while Folder B might be dedicated to holding business information and
thus be renamed BUSINESS.

..............................................................................................................................................................

Note
NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If you
do, the data on the card will get destroyed.
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Using Voice Recognition Software (Optional)

1 Connect the recorder to your PC, and start the DSS Player.

2 Change the recorder to AUDIO device.
Follow the procedure in P.76 to change the recorder to AUDIO device.

3 Click the [start] button, select [All Programs], then select [IBM ViaVoice
VoiceCenter].

When using voice recognition software such as IBM ViaVoice with the DSS Player, it is
recommended that you train your voice recognition software first to learn the characteristics of
the speaker’s voice and the recorder’s built-in microphone for maximum accuracy.
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Audio set up

4 From the [IBM ViaVoice VoiceCenter],
select [ViaVoice], [Tool], then [Analyze
My Voice]. The ViaVoice User Wizard
window appears.

5 From the [Device] list box, select
[Olympus DSS File] or [Olympus
WMA File].
Select [Olympus DSS File] or [Olympus
WMA File] in the [Device] list box, then click
the [Next] button.

6 Click the [Next] button.
The [Audio Setup Wizard] window appears.
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7 Select a sound card.
When the [Selecting a Sound Card] window
appears, select [USB Audio Device] for
[Input] and follow the instructions on screen.
(Select [Microphone Control (DVR)] for
Windows XP.)

8 Proceed with the AUDIO Setup
according to the instruction on
screen.
During audio setup, enrollment, please input
voice data from the recorder.

It is recommended that you enroll while in your normal surrounding environment settings.
This will help improve the voice recognition by registering your voice characteristics and your
environment.

..............................................................................................................................................................

Notes
• Windows 98SE or later OS is required when using voice recognition function with the recorder.
• DSS Player for Mac is not compatible with IBM ViaVoice on Macintosh.
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Using Voice Recognition Software (Optional)
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Executing Voice Recognition

1 2 3

1 Select the folder.
Select the folder containing the
dictation file you want to process with
voice recognition from the Dictation
Tree View.

2 Select the dictation file.
Select the desired dictation file to
process with voice recognition from
the Dictation List View.

3 Start of voice recognition.
Click the        icon.
The voice recognition software
window appears and voice recognition
starts.

Noise Canceling Function

Check [Use Noise Cancel] in the [Voice Recognition]
menu to output voice using the noise canceling function
to the voice recognition software.

Check the voice recognition software operating manual
for voice recognition functions such as modifying converted
characters.

The DSS Player provides a link in the menu for IBM ViaVoice Voice Recognition software. You
can easily access the menu and initiate voice recognition on any of the DSS file in the Dictation
List View.
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When recording voice to be
processed with voice recognition, set
up your DSS recorder as follows to
improve recognition accuracy.

• Set the microphone sensitivity to “DICT.”
(� P.27).

• Set the recording mode to “SP”
(� P.28).

• Set the Variable Control Voice Actuator
(VCVA) to “OFF” (� P.29).

• Register/enroll your voice in the voice
recognition software using the recorder.

• Record in a relatively quiet environment.
• Have the recorder microphone 5 to 10

cm (2 to 4 inches) away from your chin.
• Speak normally.
• It is recommended to use the noise-

cancellation microphone, ME12, when
recording.

Dictation files recorded under the
following conditions cannot be
processed by voice recognition
because their recognition accuracy
rates will be very low.

• A conference or meeting where many
voices are recorded.

• Seminar or lecture where high-level
ambient noise tends to be recorded.

Notes on Recording For Voice Recognition
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In DSS Player, designated multiple voice files can be joined and one voice file can be created.

1 Select the folder.
From the Dictation Folder Window, select
the folder which contains the files to be
joined.

2 Select the voice files.
From the Voice File List Box, select more
than one file to be joined.

3 Select  [Join]  from the [Edit]  menu.
The dialog to join files will be displayed,
listing the files selected in step 2.

Joining Files
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4 Set the order of files.
After  joined, the playback order of the files
can be changed. Select a file, and move
the file to its appropriate position in the order
using the [Up] and [Down] buttons.

5 Input File Names.
The file name is created automatically after
joining and also, it enables input optionally.

6 Press the [Join] button.
The resulting file is saved under the name
specified in step 5, and stored in the
selected folder.

5 46
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..............................................................................................................................................................

Notes
• If the files to be joined have different recording modes, the mode of the file listed at the top is selected.
• The Joining Files function is not available for the OS 9.x.
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One designated voice file can be split into the two files in DSS Player.

1 Select the folder.
Select the folder containing the file to be split
from the Dictation Folder Window.

2 Select the voice files.
Select one file to split from the Voice File List
Box.

3 Select [Split] from the [Edit] menu.
The setting dialog of the file to be split will be
displayed.

Splitting Files
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4 Set the split position.
Press the  button to playback the file, and press the  button in the position to be
divided.
Also, the playback slider position in the time axis shows the current playback position, and
also shows the split position (slide the playback slider to the right or left, which enables
moving to the position to be split).

5 Input File Names.
The file name is created automatically after splitting and also, it enables input optionally.

6 Press the [Split] button.
The splitting of the file will complete, and the file name designated in procedure 5 will be
saved.

 Playback /
 Stop button

The display will
change whenever the
button is pressed.

Split position
(Time axis)

Playback slider
Shows the current playback position
and split position.

6
4

5
Input file name
(File name before
splitting.)

Output file name
(File name after
splitting.)
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Note
The Splitting Files function is not available for the OS 9.x.
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The recorder can be used as a USB speaker or microphone when connected to a PC. If you use the
recorder as a USB speaker, you can output voice through the recorder instead of using the PC speaker.
When used as a microphone, you can record voice on your PC using you favorite application.

1 Click the  icon in the toolbar to change the recorder to Audio device.

OS X

1 From the [Tools] menu, select [Change to audio device].

USB Microphone/USB Speaker

..............................................................................................................................................................

Notes
• USB audio function cannot be used with Windows 98 or Mac OS 9.x. The USB audio function is available

only with Windows 98SE and later versions or Mac OS10.1.5 and later versions of OS.
• For Mac OS, OS10.1.5 or later versions support the USB speaker function only. Mac OS10.2.7 or later

versions support the USB microphone function as well.
• If you switch the recorder to Audio device, the recorder does not function as Storage device, and it is not

displayed as a removable drive.
• The recorder does not work as USB speaker when using the direct recording function with the DSS Player.

When the [Remote Dictation] window opens, the PC speaker will be the output device.
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1 From the DSS Player main window, click the
[Tools] menu, select [Options], then click the
[E-mail/FTP] tab.

2 Create a profile which specifies the
destination.
A profile must be created for each account to be
connected.
To create a profile, select the sending method, and
click the [Setting] button.

When E-mail is used to send and/or receive files,
select the type of E-mail service used on your system.
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3 Select a profile.
When the setting is complete, click the [OK] button to enable the setting.

Internet E-mail

Select when using E-mail, connecting to POP3 or
SMTP server via internet service provider.

Corporate or Workgroup

Select when using MAPI Compliant services such as Microsoft Exchange, Lotus Notes or
Group Wise. For details on the setting procedure, see P.78.

Sending Dictation Files/Receiving Document Files
DSS Player software can send dictation files to a third party by e-mail or FTP.

Setting the E-mail/FTP Service
E-mail/FTP service needs to be set to send/receive files.
When using E-mail and/or FTP to send dictation files attachments and/or retrieve typed
documents, it is important to configure the E-mail/FTP service in the DSS Player to match the
E-mail/FTP program you have configured on your PC. Please consult with you system
administrator if you need help with setting your E-mail/FTP service.

This process can be automated by configuring the DSS Player with the recipients profile
information and the sending method.
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Sending Dictation Files/Receiving Document Files

Installing MAPI Subsystem

Installing Microsoft Outlook 98

1 Start the Setup program for Outlook 98.
When the following window appears, select [Other
Mail Applications] and click the [Next] button.

2 When the following window appears, select
[Corporate or Workgroup] and click the
[Next] button.

3 Follow the instructions on screen.
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Setting Connection for MAPI Compliant Service

1 Click the [start] button of Windows OS, select [Settings], then [Control Panel].
The [Control Panel] appears.

2 Check whether the [Mail] or [Mail and Fax] icon  is present in the Control
Panel.

If the icon exists, the MAPI subsystem has already been installed on your computer. Go to the
“Activating Send Mail Function (Create a Profile)” section in this manual (� P.82).
If the icon does not exist, install the MAPI subsystem. The MAPI subsystem will be installed
when Microsoft Exchange Client, or Microsoft Outlook is installed.

Microsoft Outlook is included in the Microsoft Office.
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Installing Microsoft Outlook XP/2003

1 After installing Outlook XP, double-click
the [Mail] icon in the [Control Panel], and
then click the [Show Profiles…] button.

Installing Microsoft Outlook 2000

1 After installing Outlook 2000, start the
program.
When the following window appears, click the
[Next] button.

2 Select [Corporate or Workgroup] and
click the [Next] button.

3 A dialog box for setting up Microsoft
Outlook appears.
This is the wizard for creating a profile. For
information on creating a profile, check step 3
in the “Activating Send Mail Function” (� P.82).
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Sending Dictation Files/Receiving Document Files
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2 Click the [Add…] button.

3 Type the profile name and click the [OK]
button.

4 Select “Add a new e-mail account” and
click the [Next] button.

5 Select your e-mail server type.
If you are going to use an MAPI compliant
Workgroup system such as Lotus Notes or
Novell GroupWise, select “Additional Server
Types”, click the [Next] button to continue. If you
are going to use an internet standard E-mail
account, select “POP3” server, click the [Next]
button, and skip to step 7.
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6 If you select “Additional Server Types”,
you will see the following dialog box.
Click the [Next] button and follow the instructions on
the screen, then skip to step 8.

7 If you select “POP3”, you will see the
following dialog box.
Enter the necessary information and click the
[More Settings…] button.
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Click the [Connection] tab in the following dialog
box and make sure the appropriate connection
method is selected.

8 After the setup is completed, click the
[Tools] menu, select [Options], then click
the [E-mail/FTP] tab. Select the MAPI
profile name you have created.
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Sending Dictation Files/Receiving Document Files

1 Start the DSS Player and click the [Tools] menu, select [Options].

2 In the Option Setting dialog box, click the [E-mail/FTP] tab and select the
profile name you want to use.

3 Click the [Setting] button.
The Setup Wizard runs and will list the
messaging applications that comply with
MAPI. For example, if groupware such as
Lotus Notes, Novell GroupWise, or
Microsoft Exchange is installed, these
applications will be listed.

4 Select [Use the following information
services] and check one application
from the list.
If you want to set up a dialup connection
through an internet service provider, select
[Internet E-mail] in the list. If you want to
set up to use a LAN within your company,
also select [Internet E-mail] in the list.

Activating Send Mail Function (Create a Profile)
The Profile is the group of information services to set up the Messaging application. The
information services allow you to access the Mailbox and the Address Book. The Send Mail
function will not work if there is no profile. If the profile exists and has already been used for
sending E-mail, it is not necessary to create a new profile.
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..............................................................................................................................................................

Note
The Send Mail function does not work with AOL or internet service providers that cannot open
POP3 server addresses.
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Setting the Auto-Sending Function
To send downloaded dictation files automatically, follow these steps to set the auto-sending
function. This function can be individually set for the folders in the Dictation Tree View.

1 From the [Tools] menu, select [Options],
then click the [Send] tab in the Option
dialog box.

2 Check [Enable auto-sending function].

3 Select a folder to set the auto-sending
function, and check the check box.

4 Select the sending method.
Click the [E-mail] button for selecting an E-mail
address.
Click the [FTP] button for selecting an FTP
profile.

5 Click the [Next] button and follow the instructions on the screen.

6 When the wizard is complete, it returns to the profile in the Option Setting
dialog box.

S
en

d
in

g
 D

ictatio
n

 F
iles/R

eceivin
g

 D
o

cu
m

en
t F

iles

Please make sure that the profile name you have created using the Setup Wizard
is displayed in the Option Setting dialog box. If a different profile name is displayed,
switch to the profile you have created.
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Sending Dictation Files/Receiving Document Files
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Setting the E-mail destination

1 Click the [E-mail] button.
The [E-mail destination] dialog box appears.

2 Click the [To] button.
The [Select recipients] dialog box appears.

3 Select the recipient names from the
Address Book.
At least one recipient is required in the [To:->] field.
The [CC:->] and [BCC:->] selections are optional.
Click the [OK] button to finish. If the recipient
information is not present in the Address Book, use
the [New Contact] button to add new contact
information to the Address Book.

Setting the FTP destination

1 Click the [FTP] button.
The [FTP destination] dialog box appears.

2 Click the [To] button.
The [FTP Profiles] dialog box appears.

3 Select a profile from the list.
One profile can be selected. Click the [OK]
button to finish. If the correct profile does not
exist, select the [E-mail/FTP] tab in the Option
dialog box, and add the profile file for the FTP
connection.
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Setting the Document File Retrieve Function

1 From the [Tools] menu, select [Options], then click the [Receive] tab in the
Option dialog box.

2 Check the [Use collect back documents
functions] check box.

3 Select a protocol to be used for receiving
a document file.
If the transmission profile setting is not configured,
configure the setting in reference to P.77.

4 Register the format of a document file to
receive.
When using E-mail to receive a document file, the
application (software) receives the attached file if it is in
the registered file format.

When using FTP to receive a document file, the
application (software) receives the attached file stored in
the folder of destination server if it is in the registered file
format.

Any document file associated with a dictation file sent from a transcriptionist using the DSS
Player Pro Transcription Module Release 4 or later is received regardless of this setting.
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Sending Dictation Files/Receiving Document Files
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Sending Dictation Files

1 Select the dictation file you want to send from the Dictation List View.
To select more than one file, press and hold either the [Ctrl] or [Shift] key and make your
selection.

2 Right-click the dictation file, and select [Send File].
Select E-mail or FTP for the sending method.

3 Confirm the contents of the transmission template, and click the [Send]
button.

Sending Dictation Files Manually

1 In the toolbar, click the [Send/Receive files] icon  .

According to the profile set, the application establishes a connection to the server and receives
document files. The received document files are saved to the Documents folder in the Dictation
Tree View.

Clicking the [Display Dictations & Documents] icon  in the toolbar displays dictation files and
document files at the same time. By dragging and  dropping a document file to a dictation file,
the document file can be associated with the dictation file.
The document file sent as a reply from a user (transcriptionist) who uses the DSS Player Pro
Transcription Module Release 4 or later will be automatically associated with the dictation file
you originally sent to the user.

Receiving Document Files Manually
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Playing Received DSS Files

When sending DSS files to a user who does not have the DSS Player software, the user will
not be able to play the received DSS file. A free DSS Player from Olympus, DSS Player Lite,
can be downloaded from the Olympus website at:

http://www.olympusamerica.com/cpg_section/cpg_downloads.asp
http://olympus-europa.com/consumer/2590_software.cfm

S
en

d
in

g
 D

ictatio
n

 F
iles/R

eceivin
g

 D
o

cu
m

en
t F

iles

You can set the application to make a connection to the server at the certain interval for sending
dictation files and/or receiving document files.

1 From the [Tools] menu, select [Options], then click the [General] tab in the
Option dialog box.

2 Check [Auto-send/receive], and enter the time interval of automatic attempts
of sending and receiving.

3 Set the auto-sending function and the document file retrieve function
according to the instructions on P.83-85 respectively.

Sending/receiving Automatically

Dictation files are stored in the Message folder on the hard disk. If you want to send a dictation
file by attaching it to e-mail, select the file from the Message folder.

The Message folder location can be found by selecting [Options] from the [Download] menu.
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When the recorder is connected to your PC, it will be recognized on your PC as a removable
drive. You can view and access the recorder card from My Computer and download data from
the card to your PC using standard windows copy/move and delete commands. You can also
upload data from the PC to the card in the recorder in the same way.
• In Windows 98/ 98SE, you must have the DSS Player software installed for the recorder to be recognized.

Example: Copying Data from PC to Card Using Explorer or Finder

1 Start Windows.

2 Connecting the recorder to your PC.
For connection procedure, refer to “Connecting to Your PC Using the USB Cable” (� P.55).

3 Open Windows Explorer or Finder window.
The recorder will appear as a removable drive icon.

4 Copy data to card.
While the data are being written or copied, the record/play indicator lamp on the recorder
will flash.

..............................................................................................................................................................

Note
NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If you
do, the data on the card will get destroyed.

Using the Recorder as a Reader/Writer
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Alarm Message List

Explanation
Battery power is getting low.

Attempt to delete a locked
file.

The file is full of index marks
(maximum of 16 marks).

The folder is full of files
(maximum of 199 files).

The destination folder
already has the maximum
number of files (199).

An incompatible card was
inserted.

The card has no remaining
memory.

There was an error while
formatting the card.

System error detected in the
recorder.

There is no card inserted.

The card cover is not closed.

Message
BATTERY LOW

FILE
IS LOCKED

INDEX FULL

FOLDER FULL

MEMORY
ERROR

MEMORY FULL

FORMAT
ERROR

SYSTEM
ERROR

INSERT CARD

CARD  COVER
IS OPEN

Action
Charge the battery or replace
with new batteries (� P.13-15).

Unlock the file (� P.39).

Erase index marks that are no
longer required (� P.40).

Erase unnecessary files (� P.33).

Erase unnecessary files (� P.33).

Insert a compatible card.

Erase files that are no longer
required or insert another card.

Reformat the card (� P.47).

This is a malfunction. Contact
the place of purchase or
Olympus Service Center for
repair.

Insert a card (� P.21).

Close the card cover securely
until it click (� P.21).

Meaning
Low battery
power

Erase-locked

Index full

Folder full

Maximum number

Incompatible card

Zero remaining
memory

Formatting error

System error

No card

Card cover is
opened
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Troubleshooting

Probable cause
The batteries are not loaded properly.

The batteries are dead.

The recorder is in power off mode.

The recorder is in power off mode.

The batteries are dead.

The card does not have enough memory.

The card is unformatted.

The maximum number of files has been
reached.

The earphone is connected.

The VOLUME button is set to 0.

The file is locked.

The recorder was shaken during recording.

The recorder was placed near a cell phone
or fluorescent lamp while recording or
during playback.

The microphone sensitivity is too low.

The maximum number of index marks (16)
has been reached.

The file is locked.

Wrong folder.

Some PCs and USB hubs may not provide
sufficient power.

Sometimes a connection cannot be made
with some PCs running Windows XP.

Symptom
Nothing appears
on the display

Won’t start

Unable to record

No playback tone
heard

Unable to erase

Noise heard
during playback

Recording level
too low

Unable to set
index marks

Cannot find the
recorded voice

Cannot connect
to PC

Cannot connect
to a PC using a
cradle

Action
Verify polarity is correct (� P.13-14).

Charge the battery or replace with
new batteries (� P.13-15).

Turn the recorder ON (� P.17).

Turn the recorder ON (� P.17).

Charge the battery or replace with
new batteries (� P.13-15).

Erase unnecessary files or insert
another card (� P.21, 33).

Format the card (� P.47).

Check another folder.

Unplug the earphones to use the
internal speaker.

Adjust the VOLUME button.

Unlock the file (� P.39).

Move the recorder.

Set the microphone sensitivity to
CONF mode and try again (� P.27).

Erase unnecessary index marks
(� P.40).

Unlock the file (� P.39).

Switch to the right folder.

Turn the USB CHARG. “OFF” in the
recorder’s menu settings (� P.37).

You need to change the PC’s USB
settings. See DSS Player online help
for details (� P.54).
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Accessories (Optional)

PC Transcription kit: AS-4000
The AS-4000 transcription kit (sold separately) provides you with a PC-footswitch, a headset and DSS
Player Pro Transcription Module for easy transcription of DSS recordings.

xD-Picture cards of 16, 32, 64, 128, 256 and 512 MB: M-XD16/32/64/128/256/512
Olympus CAMEDIA digital camera series xD-Picture Cards can be used.

Headset: E61, E102
Stereo headset for your PC. A helpful tool for PC based transcription.

Monaural binaural earphone: E20

Noise-Cancellation microphone: ME12 (Dictation microphone)
Used to get crisp recordings of your own voice by reducing the effects of ambient noise.
Recommended to improve the accuracy when using voice-recognition software.

External microphone: ME15
A lavalier omnidirectional microphone that clips to clothing. Used to record your own voice or
people near you.

Ni-MH Rechargeable Battery Pack: BR402
High-efficiency rechargeable long life battery.

AC adapter: A511/D-7AC
Connect to the cradle to recharge the Ni-MH battery pack.

Foot switch: RS25/26
Connect to the serial or USB port of your PC for hands-free transcription convenience.

USB Reader/Writer: MAUSB-10 (Dual-Slot xD-Picture Card & SmartMedia)
Allows data to be transferred to and from a PC.

USB Reader/Writer: MAUSB-300 (xD-Picture Card)
Allows data to be transferred to and from a PC.

PC Card adapter: MAPC-10 (xD-Picture Card/SmartMedia)
Allows data to be transferred to and from a PC that has a PC card slot.

Connecting cord: KA333
Use to connect the microphone jack of this unit to a radio or other sound source.
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Recording format
DSS (Digital Speech Standard)

Recording media
xD-Picture Card: 16 to 512 MB

Input level –70 dBv
Sampling frequency

SP mode: 12 kHz
LP mode: 8 kHz

Overall frequency response
SP mode: 300 to 5,000 Hz
LP mode: 300 to 3,000 Hz

Recording time (32 MB Card)
SP mode: 5 hours 13 minutes
LP mode: 11 hours

Alkaline battery life
Recording: Approx. 20 hours
Playback: Approx. 12 hours

Ni-MH Rechargeable Battery life
Recording: Approx. 15 hours
Playback: Approx. 10 hours

Speaker
Built-in ø28 mm round dynamic speaker

MIC/EAR jack
ø3.5 mm mini-jack, impedance MIC 2 kΩ,
EAR 8 Ω or more

Maximum working output (3 V DC)
220 mW or more (8 Ω speaker)

Input power requirement
Rated voltage: 3 V
Batteries: Ni-MH Rechargeable Battery

Pack (BR402) or Two AAA
batteries (LR03 or R03) or Two Ni-
MH rechargeable batteries
(BR401)

Specifications
External dimensions

110.2 x 50.0 x 17.2 mm
(without protrusions)

Weight
101 g
(Including alkaline batteries)

* Specifications and design are subject to
change without notice.

* Battery life is measured by Olympus. It
varies greatly according to the type of
batteries used and the conditions of use.
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DS-3300 is part of the Olympus Professional Dictation System. Your dealer is trained to troubleshoot
and fix many common problems that you may be having with this system. If you encounter problems
using your DS-3300, we recommend that you contact your Olympus Professional Dealer that
sold you the system. If your dealer cannot fix your problem, please call our technical hotline
number or send an E-mail.

� For customers in the U.S. and Canada
Phone: 1-888-553-4448
E-mail: distec@olympus.com

� For customers in Europe
E-mail : dss.support@olympus-europa.com
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Technical Assistance and Support



This symbol [crossed-out wheeled bin WEEE Annex IV] indicates separate collection of waste
electrical and electronic equipment in the EU countries. Please use for the disposal of these types
of equipment with the available return and collection systems.

Applicable Product : DS-3300, Cradle P2-BZ8092-01
AP0503

Declaration of Conformity
Model Number: DS-3300
Trade Name: DIGITAL VOICE RECORDER
Responsible Party: OLYMPUS IMAGING AMERICA INC.
Address: 2 Corporate Center Drive, PO BOX 9058 Melville, NY 11747-9058, U.S.A.
Telephone Number: 800-622-6372

This device Complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Tested To Comply
With FCC Standards

FOR HOME OR OFFICE USE
Canadian RFI

This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus
as set out in the Radio Interference Regulations of the Canadian Department of Communications.

Cet appareil numérique ne dépasse pas les limites de Catégorie B pour les émissions de bruit radio émanant
d’appareils numériques, tel que prévu dans les Règlements sur l’Interférence Radio du Département
Canadien des Communications.

“CE” mark indicates that this product complies with the European requirements for safety, health,
environment and customer protection.

For customers in North and South America

For customers in Europe

Shinjuku Monolith, 3-1 Nishi-Shinjuku 2-chome, Shinjuku-ku, Tokyo 163-0914, Japan. Tel. 03-3340-2111

Two Corporate Center Drive, PO BOX 9058 Melville, NY 11747-9058, U.S.A. Tel. 1-800-622-6372

(Premises/Goods delivery) Wendenstrasse 14-18, 20097 Hamburg, Germany. Tel. 040-237730
(Letters) Postfach 10 49 08. 20034 Hamburg. Germany.

2-8 Honduras Street, London EC1Y OTX, United Kingdom, Tel. 020-7253-2772
http://www.olympus.com


